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Getting Started with 
Read Naturally SE

Read Naturally's pioneering programs offer a proven strategy to help struggling readers

improve their fluency and comprehension.  This chapter provides an introduction to

Read Naturally Software Edition (SE), the software version of our reading strategy.  

This chapter includes the following information:

� An overview of the Read Naturally strategy on which our products are based.

� Key features and benefits of Read Naturally SE.

� Guidelines for identifying students who need fluency training.

� An overview of the components of Read Naturally SE—Teacher Management,

Student Stories, and utility programs.

� A comparison of stand-alone and network installations of Read Naturally SE.

� Instructions for starting and exiting Read Naturally SE.

� Descriptions of the resources available if you need assistance using Read Naturally

SE.
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The Read Naturally Strategy

The Read Naturally strategy combines three research-proven strategies to develop

reading fluency.

Teacher
Modeling

Repeated
Reading

Progress
Monitoring

The student reads along

while listening to a fluent

reader read the story the

student has selected.

Reading along helps

students learn unknown

words and encourages

proper pronunciation,

expression, and phrasing.

The student practices

reading a story until

able to read it at a

predetermined goal 

rate.  Mastering the

story allows the student

to build fluency and

confidence.

The student is given a challenging goal

and sees immediate feedback on progress

toward that goal, motivating him or her to

read and improve.  After completing a

story, students can see before-and-after

feedback, making them aware of and

responsible for their own progress.
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Key Features and Benefits of Read Naturally SE

Students all over the country have made significant improvements in reading fluency

and in comprehension scores using the Read Naturally strategy.  A number of case

studies provide evidence of these successes.  If you would like more information about

the results of using the Read Naturally strategy, contact Read Naturally or visit our

website, www.readnaturally.com.

In addition to significantly improving fluency and comprehension, the Read Naturally

strategy positively impacts other areas of student development.  Improvements include

the following:

� Increases self-esteem and confidence.

� Gets students excited about reading.

� Encourages students to take responsibility for their own successes.

� Reduces behavior problems.

Advantages of the Software Edition

Read Naturally SE (Software Edition) provides the same powerful strategy and the same

high-interest stories as Read Naturally ME (Masters Edition) but is designed to take

advantage of the benefits and added functionality of computers.  Some of the advantages

of Read Naturally SE include the following:

� A placement program that automates the process of determining what reading level

and goal is right for each student.

� Guided steps with prompts that help students learn what to do next.

� Professional recordings of the stories, synchronized with the story text during the

read-along step.

� Vocabulary features, including spoken definitions of vocabulary words and the

ability to click difficult words to hear them spoken.

� Automatic calculation of reading scores and automatic scoring of multiple-choice

questions.

� Pictures, animations, and sounds that engage students.

� Customization options, including the ability to skip steps for advanced students

and set the amount of time allowed for steps.

� Extensive reports that automatically track students' progress and help you

determine when students need coaching or changes to their program.
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Identifying Students Who Need Fluency Training

Students who read slowly and laboriously need to improve their fluency.  A fluency

assessment tool, such as Read Naturally's Reading Fluency Benchmark Assessor, can

help you identify such students.

You can also use the information in the table below to draw conclusions and make

decisions about the oral reading fluency of your students.  Students scoring significantly

below the 50th percentile using the average score from two unpracticed readings from

grade-level materials need a fluency-building program (such as Read Naturally SE or

ME).

Oral Reading Fluency Norms

Jan Hasbrouck and Gerald Tindal completed an extensive study of oral reading fluency

in 2004.  The results of their study are published in a technical report entitled "Oral

Reading Fluency: 90 Years of Measurement," which is available on the University of

Oregon's website: brt.uoregon.edu/tech_reports.htm.

The table below shows the median oral reading fluency of students in grades 1 through

8 as determined by Hasbrouck and Tindal's data:

*WCPM = Words Correct Per Minute

Grade Percentile Fall WCPM* Winter WCPM* Spring WCPM*

1

90

75

50

25

10

0

0

0

0

0

81

47

23

12

6

111

82

53

28

15

2

90

75

50

25

10

106

79

51

25

11

125

100

72

42

18

142

117

89

61

31

3

90

75

50

25

10

128

99

71

44

21

146

120

92

62

36

162

137

107

78

48

4

90

75

50

25

10

145

119

94

68

45

166

139

112

87

61

180

152

123

98

72
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*WCPM = Words Correct Per Minute

Components of Read Naturally SE

Read Naturally SE includes the following components:

Teacher

Management 

Teachers use this component to manage student, teacher, and

class information, specify student story options, place students

in the appropriate level, and print awards and letters.  A powerful

reporting feature lets you track and analyze results for individual

students and groups of students.

Student Stories Students use this component when working with stories in their

reading levels.  Student Stories automatically leads the students

through the steps of the Read Naturally strategy.

Utilities Database utilities make it easy for you to import data, back up

data, and check who is logged in.  Customers with district server

licenses use the district administration utility to maintain the

district and school names and administrator passwords, manage

the licenses for SE levels, and generate a district usage

summary report.  Customers with school server licenses use an

install license utility to add licenses for levels they have

purchased.

Grade Percentile Fall WCPM* Winter WCPM* Spring WCPM*

5

90

75

50

25

10

166

139

110

85

61

182

156

127

99

74

194

168

139

109

83

6

90

75

50

25

10

177

153

127

98

68

195

167

140

111

82

204

177

150

122

93

7

90

75

50

25

10

180

156

128

102

79

192

165

136

109

88

202

177

150

123

98

8

90

75

50

25

10

185

161

133

106

77

199

173

146

115

84

199

177

151

124

97
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Stand-Alone vs. Network Installation

You can run the software locally on individual computers (stand-alone installation) or

from a server in a local area network environment (network installation).  The software

is available for both Windows and Macintosh operating systems.

Stand-Alone Installation

With a stand-alone installation, you run the SE applications from each computer's hard

drive.  Student, teacher, and class data is stored locally on that computer.  When students

read the stories, the CD containing the stories for their level must be in the computer's

CD drive.  Since a student's data is stored on the computer where he or she reads the

stories, each student must always use the same computer in order to keep his or her

results in one place.

Network Installation

With a network installation, the stories, as well as student, teacher, and class data, are

stored on a shared central computer called a server.   SE client software is installed on

workstations that have access to this district or school server.  This setup makes it

possible for students, teachers, and administrators to work from any workstation that has

SE installed and can access the server.
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Starting and Exiting Read Naturally SE

You can start either Teacher Management or Student Stories by double-clicking the

same Read Naturally SE icon.  This icon is placed on the Windows or Macintosh

desktop when the software is installed and is also located in the Read Naturally SE

folder.  The password you enter when you log in determines whether Teacher

Management or Student Stories starts.

To start Read Naturally SE:

1 Double-click the Read Naturally icon on your desktop. 

SE checks to see if there are any updates for the SE client software. 

If updates are available on the server, SE automatically installs them. 

Then the login screen displays.

2 Type your password, and click Enter.

� If you enter a teacher or school administrator password, Teacher Management

starts.

� If you enter a student password, Student Stories starts.

Note: For stand-alone installations, you must insert the appropriate level CD in the

computer's CD drive before you log in as a student.

� For stand-alone and school server installations, the first person who logs in after

SE is installed must enter the special password rnse to start Teacher

Management.  This password is intended for one-time use only and no longer

works once an administrator password is set up.
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To exit Read Naturally SE:

1 From either Teacher Management or Student Stories, click Quit (or choose Quit

from the File menu).  This returns you to the login screen.

2 From the login screen, you can:

� Click Exit to exit Read Naturally SE completely.

� Log in to Teacher Management with a teacher or school administrator password.

� Log in to Student Stories with a student password.
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Getting Assistance When You Have Questions or Problems

If you have questions or problems while using Read Naturally SE, you have the

following options for getting assistance:

� Check the manuals (SE Teacher's Guide, SE Software Guide, and SE Answer
Guides).

� Check the online help (Teacher Management and Student Stories).

� Check the Read Naturally website.

� Contact Read Naturally.

Check the Manuals

The manuals that ship with Read Naturally SE contain in-depth information for setting

up and using the software.  

� The SE Teacher's Guide is written from a teacher's perspective and includes

extensive information for setting up and using the software with students.

� The SE Software Guide contains information about installing the software, setting it

up for the first time, and administering the information in SE.

� The SE Answer Guides list the answers to the quiz questions.  Teachers and their

assistants can use this guide to check students' answers.

The SE Teacher's Guide and the SE Software Guide include key word indexes to help

you find specific information quickly.

Check the Online Help

SE Teacher Management and Student Stories both include online help that you can

browse or search to find answers to your questions.  Much of the information is similar

to the topics in the SE Teacher's Guide and the SE Software Guide.

To view the online help in either Teacher Management or Student Stories, select Read

Naturally Help from the Help menu.  The help opens in a separate window.  From this

window, you can locate information using the Contents and Search tabs.

Contents Tab Allows you to locate help topics by browsing through a list of the

topics available.  This option is equivalent to a book's table of

contents.

Search Tab Provides full-text search capabilities.  To search, enter a word or

phrase and then either click the Find button or press the Enter key.

The search locates all occurrences of the word or phrase throughout

the help system and displays a list of help topics found.



Check the Read Naturally Website

If you have problems using Read Naturally SE, check the support section of the Read

Naturally website:

www.readnaturally.com/support/

The support pages include frequently asked questions, knowledgebases, troubleshooting

information, updates to the software, electronic files of the manuals, and more.

Other pages on the website contain background information about the Read Naturally

strategy, case studies illustrating the effectiveness of the strategy, and information about

Read Naturally products and seminars.

Contact Read Naturally

You can contact Read Naturally with questions, problems, or to order additional

products.

Online Software

Support Request

www.readnaturally.com/support/supportRequest.htm

Telephone 651.452.4085 or 800.788.4085

Fax 651.452.9204

E-mail Address

for General Issues

info@readnaturally.com

Website www.readnaturally.com

Office Hours Monday through Friday

9:00 a.m.  to 5:00 p.m.  Central Time

Getting Started with Read Naturally SE 10 Copyright © 2004–2007 Read Naturally, Inc.
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Using Teacher Management

The Teacher Management component opens when you log in to Read Naturally SE with

a teacher or administrator password.  You use Teacher Management to set up and

maintain the following information:

� School information—the school name, district name or number, and administrator

password.

� Teacher information—the names and passwords of the teachers and teacher

assistants who use Read Naturally SE.

� Class information—the names of the classes and the teachers assigned to them.

� Student information, including:

– Identification and profile information, such as the student's name, ID, password,

grade, class, teacher, and characteristics.

– Story options, including their goal, level, and SE step options.

You can also perform the following tasks from Teacher Management:

� Reset stories if a student has difficulty passing a story.

� Place students in the appropriate level and goal by testing them with sample stories.

(For information on placing students, see Chapter 3.)

� Print awards and parent letters for students.

� Print the stories in a level.

� Generate reports to analyze data for the school, classes, teachers, or individual

students.  (For information on reports, see Chapter 7.)

Logging In to Teacher Management

You can log in to either Teacher Management or Student Stories from the same 

login screen.  When you log in with a teacher or school administrator password, Teacher

Management starts.

2
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Changing Your Teacher Information

Teachers can change their own name and password.  The school administrator can add

teachers, delete teachers, and change any of the teachers' names and passwords (see the

SE Software Guide for more information).

To change your teacher information:

1 Log in with your teacher password.

2 Select the Teachers tab.

3 Change your name or password as necessary.

4 Click Save.

Searching the Class and Student Lists

Teacher Management has sort and search features to help you find students and classes.

The administrator can also sort and search the teacher list.

To sort a list Click a column heading to sort by that column.

To search a list 1 Click the heading of the column you want to search.

2 In the Find box at the bottom of the window, type the text

you want to search for.

3 Click Find.  The list shows the items that match your search.

Click Show All to see the complete list again.
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Maintaining Class Information

Teachers can add, rename, and delete only those classes that are assigned to them.  The

administrator can add, change, and delete any of the classes.

To maintain class information:

1 Log in with your teacher password.

2 Choose the Classes tab.

3 Perform any of the following actions:

Add a class a Click Add.

b Specify a class name.

c Administrators must select a teacher from the drop-down

list to assign the class to him or her.  When teachers add

classes, the classes are automatically assigned to them.

c Click Add to add another class, or click Save to return to

the class list.

Edit a class a Choose the class you want to change.

b Click Edit.

c Edit the class as necessary.  Teachers can only change

the name of the class.  Administrators can also change

the teacher assigned to the class.

d Click Save.

Delete a class a Choose the class you want to delete.  You cannot delete

classes with students assigned to them.

b Click Delete.

c Click Yes to confirm.
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Maintaining Student Information

If you log in as a teacher, you can add, change, and delete only those students that are

assigned to you.  If you log in as an administrator, you can add, change, and delete

students assigned to any of the teachers.

You can enter an unlimited number of students into the Teacher Management System.

To maintain student information:

1 Log in with your teacher password.

2 Choose the Students tab.

3 Perform any of the following actions.

Add a student a Click Add.

b Complete the following required information (blue

headings):

� First Name/Last Name

� Grade

� Password: This is what the student will enter when

logging in.  It must be 3 to 14 characters long.

� Teacher: If you log in as a teacher, no selection is

necessary, since all of the students you add are

assigned to you.

� Class: Choose the class to which the student

belongs.  Only the classes assigned to the current

teacher are available.

c You can also provide the following optional information:

� Student ID

� Characteristics (gender and type of student)

d Click Add to add another student or click Save to return

to the student list.

e Click Yes to set up the student's story options right away

(see Chapter 3), or click No to set them up later.

Edit a student's

identification

information

a Either double-click the name of a student, or choose a

student and then click Edit.

b Change the student information as necessary.  

c Click Save.

Delete a student a Choose the student you want to delete.

b Click Delete.

c Click Yes to confirm.
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Resetting Stories for a Student

If a student is struggling with a story and cannot pass it, you can reset the story and allow

the student to try it again later.

Note: Only teachers and the administrator can reset stories.  Teacher assistants cannot reset

stories.

To reset stories for a student:

1 Access student options in either of the following ways:

� Log in with a teacher password to start Teacher Management.  From the Student tab,

choose a student, and then click Story Options.

� From Student Stories, choose Story Options from the Edit menu.  Then enter your

teacher password, and click OK.

2 Choose the Advanced tab.

3 Choose the story you want to reset, and click Reset.

4 Click Yes to confirm.

5 Click Save.

Reassign 

students

a Select the students you want to reassign.  

� To select a group of students that are listed together,

click the first student, hold down the Shift key, and

then click the last student.  

� To select multiple students that are not listed

together, hold down the Control key (Windows) or

the Command key (Macintosh) and then click the

students you want to reassign.

b Click Reassign.

c Specify the new class and grade to which you want the

student assigned.  Administrators can also reassign

students to another school (district licenses only) and

teacher.

d Click Save.

e Click Yes to confirm the changes.
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Printing Awards and Letters

Read Naturally SE provides the following documents for communicating with parents:

� A letter introducing the Read Naturally program that you can give to parents when

their children begin working with the program.

� A periodic report that tells parents about the progress that their children have made

in the Read Naturally program (see Chapter 7 for more information).

� A Super Reader award you can send home to parents when their child completes 

12 stories in a level.

You can use awards to keep parents involved in the learning process.  After a student

passes 12 stories in a level, you may want to staple printed copies of the stories together,

attach the award as a cover letter, and ask the student to take the booklet of stories home

to read and discuss with his or her parents.  Parents can then sign the award, and the

student can return the bottom portion to you.  

To print a parent letter:

1 Log in with your teacher password.

2 From the Students tab, choose a student, and click Letters.

3 Choose Parent Letter, and click OK.  The parent letter opens in a separate window.

Because the student's name is not included in the letter, you can send the same letter

to all of the students in a class.

4 To print the letter, choose Print from the File menu.  If you want to print multiple

copies, change the quantity in the Print dialog.

5 Be sure to sign the letters before sending them home with students.

To print a Super Reader award:

1 Log in with your teacher password.

2 From the Students tab, choose a student and click Letters.

3 Choose Super Reader Award, and click OK.

4 Choose the level for which the student has completed 12 stories, and then click OK.

The Super Reader Award opens in a separate window with the student's name, the

level, and the goal rate he or she achieved.

5 To print the award, choose Print from the File menu.

6 Sign the award, and add comments to personalize it for the student.

7 Send the award home with the student, and include copies of the stories he or she

completed.  For information about printing the stories, see "Printing the Stories in a

Level" on the next page.
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Printing the Stories in a Level

From Teacher Management, you can print one or more of the stories in a level,

including the quiz questions, regardless of which levels and stories students are 

working in.

To print the stories in a level:

1 Log in with your teacher password.

2 From the File menu, choose Print Stories.

3 Select the level for which you want to print stories. Only licensed levels are shown.

4 Select the stories you want to print.

� To select one story, click the story name.

� To select all of the stories in a level, click Select All.

� To select a group of stories that are listed together, click the first story, hold

down the Shift key, and then click the last story.

� To select multiple stories that are not listed together, hold down the Control key

(Windows) or key (Macintosh) and then click the stories you want to print.

5 Click OK. The selected stories open in your default web browser.

6 To print the stories, choose Print from the File menu.
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Working With Students

This chapter includes the following information:

� A summary of teachers' responsibilities for setting up and using Read Naturally SE

with their students.

� Guidelines for setting up your workspace for Read Naturally SE.

� Explanations of the concepts of instructional level and reading rate goal.

� Instructions for placing students in an appropriate level and goal.

� Instructions for setting up story options for students.

� A lesson plan for introducing Read Naturally SE to your students.

� Guidelines for monitoring students and determining when to adjust their levels or

goals.

Use the information in this chapter as a guideline.  You need to use your knowledge of

your students in conjunction with these guidelines to determine the correct level of

material and to set developmentally appropriate goals for them.

3
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SE Teacher Responsiblities

Teachers have the following responsibilities for setting up and using Read Naturally SE

with their students:

1 Set up your schedule and workspace, gather the materials you will need, and set up

the computers (see below).

2 Place the students to determine the appropriate goal and level of material (see

"Placing Students" in this chapter).

3 Set the story options for the students in Teacher Management (see "Setting Up Story

Options for Students" in this chapter).

4 Teach behaviors, such as logging on to Student Stories and following the steps (see

"Lesson Plan to Introduce Read Naturally SE" in this chapter).

5 Monitor the students' progress by timing them every two weeks to make sure the

goal rate and reading level of material are correct (see "Adjusting Levels and Goals

for Students."

6 Communicate with students and parents.  Periodically, take time to recognize

students' progress and to let parents know how their children are doing.  (See

"Printing Letters and Awards" in Chapter 2.)

Setting Up Your Workspace

You can use Read Naturally SE in a variety of settings, depending upon where

computers are available, such as a classroom, media center, or computer lab.

You need to set up your workspace differently depending on whether you install the

applications on individual computers (stand-alone setup) or on a server (network setup).

With either option, it is helpful to hang a Read Naturally SE poster in the room and to

make SE Answer Guides available in a central location.

Materials You Will Need

To use Read Naturally SE, you need the items listed below:

� Computer workstation(s)

� Headphones

� Appropriate level CD for each student (stand-alone installations only)

� SE Answer Guides for checking the students' answers to the quiz questions

� Read Naturally SE poster (optional)

� Student folders for copies of the stories, awards, results, etc. (optional)
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Read Naturally sells headphones, additional SE Answer Guides (one copy is

complimentary), folders, and posters.  For more information, contact Read Naturally 

or visit the Read Naturally website at www.readnaturally.com.

Stand-Alone Setup

For stand-alone installations of Read Naturally SE, you need to make the CDs for the

appropriate levels available to each student.  If you have multiple students working in

the same level, you may want to purchase enough CD albums to divide the CDs

according to level.  You can also group the CDs within an album by color (they are

color-coded by level).  We recommend labeling the spine of the CD albums to indicate

which level(s) are included.

In a stand-alone setup, each student should use Student Stories on the same computer

every time to keep all of his or her results in one place.

Network Setup

For network installations of Read Naturally SE, the student does not need access to 

the CDs.  The stories and student results are stored on a school or district server.  As 

a result, students can use Student Stories from any computer that is connected to the

network and set up with the SE client software.  

Make sure that the SE icon is on the desktop of the computers where students will use

Student Stories.

Poster

You can hang a Read Naturally SE poster on the wall near the computers where the

students will work.  The poster helps the students understand the process and provides

them with helpful tips for using Student Stories.

SE Answer Guides

You should make SE Answer Guides available in a central location where each

individual who will pass students (for example, teaching assistants and volunteers) 

can locate one.  The SE Answer Guides include the answers to the questions in the 

quiz step.  The computer automatically corrects the multiple-choice questions, but 

you need to correct the open-ended questions during the Pass step.  If you need

additional SE Answer Guides, you can order extra copies from Read Naturally.
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Levels and Goals

When you place students, you establish both an instructional level and a reading rate

goal that are appropriate for each student.  You also select the type of curriculum that

best meets the needs of each student.  Correctly placing a student is crucial to the

student's success in Read Naturally.  The combination of instructional level and goal rate

should challenge the student without being frustrating.  

Levels

Reading levels indicate the degree of difficulty.  Read Naturally assigns levels to its

materials, from first to eighth grade reading level, based on the following readability

formulas:

� Fry and Spache readability formulas for levels .8 through 2.7.

� Harris-Jacobson readability formula for levels 3.0 through 5.0.

� Dale Chall readability formula for levels 5.6 and above.

When a student begins Read Naturally, use the placement program to place the student

in the initial level.  The level of reading material needs to be sufficiently difficult to

challenge the student with new words and/or more complex sentences.  The level of

material needs to be easy enough that the student can pass a story after reading along

and then practicing the story five to ten times.

As the student continues to work with the program, adjust the difficulty of the reading

material to meet the changing needs of the student.  For more information, see

"Adjusting Levels" in this chapter.

Types of Curriculum

The following levels and types of curriculum are available for Read Naturally SE:

Sequenced levels are the basic curriculum and are appropriate for any developing or

struggling reader.  The sequenced levels build fluency and support comprehension and

vocabulary growth.  

Sequenced Phonics
American Manners &

Customs, Idioms

1.0

1.5

2.0

2.5

3.0

3.5

4.0

4.5

5.0

5.6

6.0

7.0

8.0

.8

1.3

1.8

2.3

2.6

2.7

3.0

3.5

4.0

4.5
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The Phonics levels, like the sequenced levels, are primarily designed to build fluency.

But the phonics levels also include features that focus on decoding specific phonics

patterns.  Each story includes many words with the featured pattern, a short audio

phonics lesson, and a word list activity.

The American Manners and Customs levels are designed to acquaint English

language learners with some American manners and customs as they work on reading

fluency and comprehension.  The stories include extra audio and vocabulary support.

With the Idioms levels, both native speakers and English language learners can learn

common American idioms as they work on reading fluency.  The stories include extra

audio and vocabulary support.

Goals

The reading rate goal is the number of words a student must read correctly per minute in

order to pass a story.  For each student, you set a predetermined goal that is appropriate

for his or her current reading ability.  The goal needs to be sufficiently high to require

the student to practice reading the story many times in order to achieve the goal rate, but

not so high that the student becomes frustrated.

After you have set the initial goal for students, they usually keep that goal for at least

six stories, typically about two weeks.  You can adjust the goal as the students' reading

fluency improves.  For more information, see "Adjusting Goals" in this chapter.

Placing Students

Read Naturally SE includes a placement program that automates the process of

determining what level and goal are appropriate for a student.  The placement program's

recommendations are only guidelines.  You should select the goals and levels best suited

for your students.

The table on the right shows the guidelines the

placement program uses to determine which

level is appropriate.  To determine the goal, the

placement program adds 40 to the student's

score for grades 5 and above and 30 to the

score for grades below 5.  The goal is then

rounded up or down to the nearest 5 to make it

easier for students to work with their goals.

Beginning readers can start in Read Naturally

level .8 or 1.0 when they know beginning

sounds and can recognize approximately 50 words.  The initial goal is typically around

50 wcpm in level .8 and about 60–70 wcpm in level 1.0.

Placement

Testing Level

Scores in This

Range Indicate a

Potential Fit

1.0 to 3.0 30 – 60 wcpm

3.5 to 5.0 60 – 80 wcpm

5.6 to 7.0 80 – 100 wcpm

8.0 100 – 140 wcpm

wcpm = words correct per minute
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To place students using the SE placement program:

1 Log in with your teacher password.  (Teacher assistants cannot place students.)

2 Choose the Students tab.

3 Select the student you want to place, and then click Place.

4 Estimate the level at which the student is currently reading.  You can base this

estimate on test results, your own knowledge and experience, or a formal

assessment tool, such as Read Naturally's Reading Fluency Benchmark Assessor.

Select the placement testing level, and click Next.

If you have not purchased SE curriculum at the instructional level you selected, a

warning is displayed.  Click Yes to continue testing the student with the level you

selected, or click No to select another level.  A story at the level you selected opens.

5 If desired, click the Reading Guide icon to turn the reading guide on or off.  The

reading guide can help the student follow along.

6 When the student is ready to start reading, have him or her click Start.

7 As the student reads aloud, listen and silently count the number of errors he or 

she makes.  (See the description of the Pass step in Chapter 5 for guidelines for

counting errors.)

8 When the bell sounds, click the last word the student read.

9 Enter the number of words the student missed, and then click Next.

The placement program analyzes the results and either recommends a level and goal

or recommends that you test the student at a higher or lower level.

10 Depending upon the situation, take one of the following actions:

If the placement program

recommends a level and

goal...

Choose Select Level/Curriculum and Goal,

select a curriculum for the student, and then

click Next. Curriculum you have not licensed is

dimmed.

If the placement program

recommends testing the

student at another level...

Choose Continue Testing and click Next to test

the student with another story, and then repeat

the process.

Continue to test the student at additional levels

until the placement program recommends a

level and goal.

If you think you have

enough information to

place the student on

your own without a

recommendation...

1 Choose Manually Set Level and Goal and

click Next.

2 Enter the level and goal in the story options.

3 Click Save.
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Setting Up Story Options for Students

In the story options, you customize the Read Naturally process for each student.  

You set each student's level and goal, specify which steps are included, and tailor 

the behavior of the program to suit each individual student.

You can access story options from either Teacher Management or Student Stories.  

From Teacher Management, teachers can set up or change the options for all of their

students.  From Student Stories, teachers can only change the options for the student 

that is currently logged in.  Teacher assistants cannot set up or change story options.

To set up story options from Teacher Management:

1 Access story options in either of the following ways:

� Log in with a teacher password to start Teacher Management.  From the

Students tab, choose a student and then click Story Options.

� From Student Stories, choose Story Options from the Edit menu.  Then enter

your teacher password, and click OK.

3 Change the story options as necessary.  Click the Advanced tab for more options.

The options are described in the tables below.  

4 Click Save.

Basic Tab: Placement

Goal Specify the reading rate, in words correct per minute, that you are

setting as the student's goal.

Level Select the student's instructional level as determined by placement

tests or previous Read Naturally results.  Only the levels installed

on your system are listed.

Set Select which set of stories you want available for students:

� Set 1: Only the first 12 stories in the level are available.

� Set 2: Only the second 12 stories in the level are available.

� Auto: When the student starts the level, the first 12 stories are

available.  When the student finishes all 12 stories, the second

12 stories automatically become available.

If you choose Set 1 or Set 2, when the student finishes all 12

stories in the set, the teacher must manually change to the other

set to make the other 12 stories available.  This gives the teacher

a chance to check a student's progress before he or she continues

with the rest of the stories.  For instance, the teacher might decide

to raise the student's level rather than have him or her read the

rest of the stories in the current level.
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Basic Tab: SE Steps

The steps that are checked are included as a student works through a story.  This lets

you customize the process for each student.

Basic Tab: Phonics Options

The following option is available only if a phonics level is selected.

Word List Check this box to include the Practice Word List and Pass Word

List steps.  See Chapter 6 for more information.

Key Words Check this box to include the Key Words step.

Prediction Check this box to include the Prediction step.  You can also

change the length of time allowed for writing the prediction.

Cold Timing Check this box to include the Cold Timing step.

Read Along Check this box to include the Read Along step.  You can further

customize the Read Along step with these options:

� Vocabulary: Check this box to to let students click vocabulary

words to see and hear their definitions.

� Required Listening: Specify how many times the student is

required to read along (up to 7).  The default is 3.

� Speeds: Specify the reading speed for each of the read

alongs.  For three read alongs, the recommended settings 

are normal for the first one, 7.5% increase for the second

one, and 15% increase for the third one.

Questions Check this box to include the Quiz step.  If you check the Open-

ended questions box, all of the questions are included.  If this box

is not checked, open-ended questions (typically questions 5, 8, and

9) are not included.

Retell Check this box to include the Retell step.  You can also change the

length of time allowed for writing the retell.

Students may be able to skip the Retell step when they can read

material half a year to a year above their grade level with very few

errors and with fluency approaching grade-level expectations on

cold readings.
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Advanced Tab

Practice/Pass

Timings

Select how you want to time the student in the practice and pass

timing steps:

� 1-minute: Students read for one minute, after which a bell

sounds, and they click the last word they read.

� 2-minute: Students read for two minutes, after which a bell

sounds, and they click the last word they read.

� Whole story timing: Students read the whole story and click

the Finished button when they are done.

Cold Timing Check student to allow students to start cold timing on their own.  

Check teacher required to require a teacher to enter a password

before cold timing can begin.  This option lets you observe the cold

timing to make sure it is accurate.

Word List

Timings

Phonics levels only: Select either 45 seconds or 1 minute as the

length of time allowed for the word list timings.  Forty-five seconds

may be enough time for lower levels with shorter word lists.

Reset Stories If a student is struggling with a story and cannot pass it, you can

reset the story and allow the student to try it again later.  To reset a

story:

1 Choose the story you want to reset.

2 Click Reset.

Enable

Instructional

Audio

Check this box if you want students to hear audio instructions that

tell them what they need to do as they work through the steps.

Once a student is familiar with the process, you may be able to

turn off the audio instructions.

Reset all

options to

defaults

Click this button to return all of the options to their original settings.
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Lesson Plan to Introduce Read Naturally SE

Before asking students to begin working independently, you may want to demonstrate

Student Stories and walk through the steps of the process together.  To demonstrate, you

can work through one or two stories together.

Setting Up the Lesson

For the purpose of the demonstration, you can set yourself up as a student and set your

story options to an appropriate level, goal, etc.  You can delete yourself as a student

after the demonstration.  For more information, see "Maintaining Student Information"

in Chapter 2.

First Demonstration

Opening Student Stories

1 Show the students how to open Read Naturally SE.  Make sure they see what the

icon looks like and how to double-click it to open the login screen.

2 Show the students how to enter a password and click the Enter button.  Explain that

they will each have their own password.

Select a Story Step

1 Select a story to read.

2 Explain as you demonstrate that they must click the story, and then verify that

Student Stories opened the correct story.

Key Words Step

1 Tell the students to read along as the key words are spoken.

2 Tell the students they should click the key words they don't know to see and hear

their definitions.

Prediction Step

1 Look at the title, key words, and picture.  Discuss what the story might say about

the topic.

2 Point out that they can click the Back button to return to the Key Words step if they

want to review the key words and what they mean.

3 Show the students how to type their thoughts into the text box.  Use this opportunity

to teach how the text boxes work.  

4 Click the Next button to continue to the Cold Timing step.  Explain that they will

often need to click Next to go to the next screen, and that the software will not let

them click Next until they complete what they need to do on the current screen.
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Cold Timing Step

1 Explain that Student Stories will time them as they read the story.

2 Explain what the reading guide will do, and show how to turn it on and off using the

reading guide button.

3 Point out the speaker/question mark button in the upper left-hand corner, and

demonstrate how it repeats the audio instructions.  Explain that the icon is available

throughout the process.

4 Click the Start button, explaining to the students that they will click this Start

button when they are ready to begin reading.  Instruct them to read the story aloud,

but quietly.  At this point, you may want to point out the reading guide again.  If

you turned it on, they can see what it looks like.

5 Tell the students that as they read they should click on the words they are unsure of.

Click on a word to demonstrate how the unknown words change color.

6 If you demonstrate with level 5.6 or above, show the students how to advance to the

second page of the story by clicking the More button.

7 Wait for the bell to sound, and then show the students how to click on the last word

they read.  Click the Next button to display the cold timing graph.

8 Point out that the cold timing graph fills in blue to the number of words read

correctly per minute.  Point out that their goal is on the graph.  Click the Next

button to continue to the Read Along step.

Read Along Step

1 Explain to the students that they will read along with the story three times (or

however many times you determine).  Teach students that they can't just listen 

to the narrator but must quietly read aloud.

2 Click the Start button to begin the first reading.  Point out that the sentence displays

in blue as the narrator reads it.

3 Show the students that they can tell how many more times to read along by holding

the cursor over the Read Along tab.  At the end of the first read along, point out that

there are two read alongs left (assuming they were set up for three read alongs).

4 Begin another read along, and show the students that they can stop if necessary by

clicking on the Stop button above the story.  Point out that the number of read

alongs left did not change, because you did not complete the read along.

5 After completing all the required read alongs, tell the students that they can read

along again if they think it's necessary.  Otherwise, they can click the Next button to

continue to the Practice step.
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Practice Step

1 Explain to the students that they will practice the story until they can read it at their

goal rate.  You can tell each student his or her goal or tell all the students that you

will inform them of their goals later.

2 Show the students how to click the Start button to begin practicing.  You should

practice without reaching the goal the first couple of times.

3 Show the students that the practice scores display at the bottom of the screen so 

they can tell when they are getting closer to the goal.  You may want to turn off 

the reading guide for one of the practice readings so the students can see what it

looks like when the reading guide is off.

4 Show students they can click on a word to hear it pronounced.

5 If you demonstrate with level 5.6 or above, show the students how to advance to the

second page of the story by clicking the More button at the bottom of the screen.  If

you demonstrate with level 5.0 or below, click the Finished button before the timer

sounds to show the students that they can use this button if they finish reading the

story before the bell sounds.  When you reach the goal, click the Next button to

continue to the Questions step.

Exiting Before Finishing a Story

1 Click the Quit button to exit the program, and explain to the students that they can

exit the program at any point if the class period ends while they are in the middle of

a story.

2 Log in again with the same student password.  Point out that Student Stories brings

them back to the point where they left off in the story.

Questions Step

1 Answer the questions, making sure the students understand the mechanics of

answering each type of question (e.g., click the letter for multiple choice, click the

word that belongs in the highlighted line for fill in the blank, type in the text box for

open-ended questions).  The question format depends on the level.

2 Answer one of the multiple-choice questions incorrectly to demonstrate how Student

Stories asks the students to re-answer the questions that they answered incorrectly.

Explain that they cannot pass until they answer all the questions correctly.



Retell Step

1 Tell the students that after they answer the questions, they will retell the story.

2 Discuss what the story was about.

3 Show the students how to click the Review Story button to see the story one last

time.  Explain that they can return to the story only once before completing the

retell.  After closing the story, point out that the Review Story button is no longer

available.

4 Type a retell.  If you will have requirements for the retell (e.g., at least three ideas),

explain them to the students.  Click the Next button to continue to the Pass step.

Pass Step

1 Point out that a red "Ready to Pass" box displays at the top of the screen to alert you

that it's time to pass the story.  Tell the students that they should continue practicing

while they wait for you to come over to them.

2 Begin a practice timing.  Stop the practice timing by clicking the Stop button above

the story to show that, when the teacher comes, they can stop their current timing

and move on to the Pass step.

3 Click the Pass button, and enter your teacher password.  You may want to click this

button and enter your password without commenting about what you are doing.  If

you provide too much information, you may increase the students' interest in trying

to pass themselves.

4 Tell the students that, for the pass timings, you will click the Start button when you

hear them begin to read.  For whole-story timings, click the Finished button when

the student finishes the story.  For one- or two-minute timings, wait for the bell to

sound, and then click on the last word the student read.  Then enter the number of

errors and the expression rating, and correct the open-ended question(s).  You may

want to fail one of the criteria needed to pass to show the students what will happen

if they don't pass the first time.  For more information, see the description of the

Pass step in Chapter 5.

5 Once you pass all of the criteria, the final timing graph displays.  Point out that the

graph displays the number of words read correctly and fills in the space between the

cold timing number and the passing number in red.

6 Click the Graph Stories button.  Show the students that the stories they passed in

the level will all display on the graph so they can see their progress from story to

story.  (Before the demonstration, you may want to pass a different story in the level

so that the graph displays more than one story.)

7 Click the New Story button to show the students that after passing a story, they

begin the process again.
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Second Demonstration

If you have the resources, running through the steps a second time with each of the

students at their computers may further increase their understanding of the program.  

If you do a hands-on demonstration, you need to set up each student's story options 

for the level they will use during the demonstration.  Once you finish, delete each 

story used during the demonstration so those stories do not show up in your official

report results.  For more information, see "Resetting Stories for a Student" in Chapter 2.

Adjusting Levels and Goals for Students

As students' reading fluency improves, you will need to adjust their levels and 

goals to ensure that they are sufficiently challenged and will continue to improve.  

The information below provides guidelines for monitoring students' progress 

and adjusting their levels and goals.

Monitoring Progress

You should review each student's results every two weeks to determine if the goal rate

and level of reading material are still correct.  After the student completes the first set of

stories in a level (12 stories), you and the student should decide on the next step.

Options are as follows:

� Continue in the same level with the same goal.

� Adjust the reading rate goal.

� Move to a more difficult level of reading material.

Adjusting Goals

You should adjust the students' goals as their reading fluency improves.  You can change

the goal at any time, but do not increase the goal at the same time you raise the level of

reading material.  You can adjust a student's goal in the Story Options screen from either

Teacher Management or Student Stories.

Increasing the Goal

Increase the students' goal if they pass stories after only a few practice readings, if 

they pass stories in less than one class session, or if they exceed their goal consistently.

Usually, you will increase a goal by 10 words correct per minute at a time.  The goal

must be sufficiently high to require the student to practice the story several times after

reading along with the program.

Decreasing the Goal

You will rarely decrease a goal.  You may decrease a goal if students cannot pass a story

after several practice readings and show signs of frustration.  You may also decrease a

goal if the error rate is too high as a result of too much emphasis on speed.
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Adjusting Levels

As students continue to work with the Read Naturally program, adjust the difficulty of

the reading material to meet their changing needs.  You can adjust a student's level 

on the Story Options screen from either Teacher Management or Student Stories.

Maintaining the Level

You will usually maintain the difficulty of the reading material until the student finishes

all 24 stories in a level.  When students begin to pass the stories without practicing

several times, consider increasing the goal first.  Occasionally, a student will improve

enough to skip the second 12 stories in a level.  

Increasing the Level

After students read 24 stories in a level, they work in the next level of reading material.

The goal usually remains the same at the time you increase the level of difficulty.

Occasionally, a student improves significantly before passing all 24 stories in a level.

Evidence of this improvement is the student's ability to read unpracticed stories well

after reading along only once or not at all.  If students make rapid progress, raise the

difficulty level of material even if they have not read all 24 stories in the level.

Decreasing the Level

Decrease the level of material if a student cannot pass stories after several practice

readings and shows signs of frustration.  Also, consider decreasing the level of material

if a student consistently makes a high number of errors during the final timing or if the

student has extreme difficulty answering questions correctly or writing retells.

Increasing Independence

When students can read material half a year to one year above their grade level, with

very few errors and at a fluency approaching grade-level expectations on cold readings,

you may want to drop the teacher modeling (Read Along) step.  The students should still

do a cold timing, practice readings, a pass timing, retell, etc.  
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Using Student Stories

Student Stories opens when you log in to Read Naturally SE with a student password.

Student Stories automatically leads students through the Read Naturally steps as they

work with the stories in their reading levels.

This chapter includes the following information:

� Descriptions of the common features of the Student Stories screens.

� Descriptions of the Student Stories menu options.

� Descriptions of the Scores summary available from the Student Stories screens.

� Procedures for changing students' story options, changing Student Stories

preferences, and printing stories and students' results.

See Chapter 5 for in-depth instructions for the steps that students follow when working

with stories in Student Stories.

Logging In to Student Stories

You can log in to either Teacher Management or Student Stories from the same login

screen.  When you log in with a student password, Student Stories starts.

For stand-alone installations, the level CD must be in the computer's CD drive before

you log in to Student Stories.

4
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Common Features of the Student Stories Screens

The following diagram shows some of the common features of the Student Stories

screens.  The Windows version of the screen is shown below.  In the Macintosh version,

the title bar and menu bar will appear differently.

Quit Button: Click this to

exit the story and return

to the login screen.

Reading

Guide:

Highlights

each line

to help the

students'

eyes track

correctly

across the

line.

Reading

Guide

Icon:

Click this

to turn the

Reading

Guide off

and on.

Scores: Click this to view 

a summary of the student's

options and progress so

far.  See page 38 for more

information.

Progress Bar: Shows all of

the steps and highlights the

current step in blue.

Menu Bar: See the next

page for descriptions of

the menu options.  On

Macs, the menu bar is 

at the top of the screen.

Title Bar: Shows the story

title and reading level.

Audio Instructions

Icon: Click this to hear

the audio instructions

repeated.

Next Button: Click

this to advance to

the next step.

Back Button: Click

this to review the

previous step.

Start/Stop Icon: Click

this to start and stop

timing.  If you stop and

restart, timing starts over.
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Student Stories Menu Options

The Student Stories menus include the following options:

File Menu

Edit Menu

Retest Menu

Help Menu

Print Screen Prints the Congratulations screen at the end of a story.

Print Prints the story elements and student results you select.

Quit Closes Student Stories and returns you to the login screen.

Read Naturally

Help

Displays help information that explains how to use Student Stories.

See "Getting Assistance When You Have Questions or Problems"

in Chapter 1 for more information.

About Read

Naturally

Displays the SE version number and contact information for Read

Naturally.

Cold Timing Discards the student's previous Cold Timing score and lets the

student repeat the Cold Timing step.

Pass Timing Discards the student's previous Pass Timing score and lets the

student repeat the Pass Timing step.

Word List Discards the student's previous Pass Word List score and lets the

student repeat the Pass Word List step.  This option is available

only for phonics levels.

Story Options Lets you change the story options for the current student (requires

a teacher password).  See "Setting Up Story Options for Students"

in Chapter 3 for more information.
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Scores Summary

Starting with the Read Along step in Student Stories, students or teachers can click

Scores in the upper right corner (see "Common Features of the Student Stories Screens"

in this chapter) to display a quick summary of the student's settings and his or her

results for the current story up to that point.  Depending on which step the student is

currently working on, the Scores summary can display some or all of the following

information:

Level The reading level currently assigned to this student in the story

options.

Set Which set of stories in the level is currently available to the

student—1 (for the first 12 stories) or 2 (for the second 12

stories).

Goal The reading rate, in words correct per minute, that is currently

set as the student's goal.

Cold Timing The number of words correct per minute that the student read

during the Cold Timing step.

Difficult Words The unknown or difficult words that the student clicked on

during the Cold Timing and Practice steps.  Click � to view
them.

Read Along

Required 

The number of times the student is required to read along.

Read Along Times The number of times the student actually read along.

Practices to Goal The number of times the student had to practice reading the

story before reading at the goal rate.

Total Practices The total number of times the student practiced reading the

story.

Highest Practice

Score

The student's fastest reading rate, in words per minute, during

the Practice step.

Retell Word Count The number of words in the retell that the student wrote.

Initial Quiz Score The number of questions the student answered correctly the

first time he or she took the quiz.

Hot Timing The number of words correct per minute that the student read

during the Pass timing.
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Changing Story Options for Students

You can change the story options for students while they are working in Student Stories.

Note: Only teachers and the administrator can change story options.  Teacher

assistants cannot change story options.

To change the story options from Student Stories:

1 From the Edit menu, choose Story Options.

2 Enter your teacher password, and click OK.

3 Change the student options as necessary.

� Click the Advanced tab for more options.

� For detailed descriptions of all of the options, see "Setting Up Story Options for

Students" in Chapter 3.

4 Click Save.
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Printing Stories and Student Results

From Student Stories, you can print the current story and its vocabulary words as well

as all or part of the student's results for the current story.

To print a story and/or a summary of a student's results:

1 From the File menu in Student Stories, choose Print.

2 Enter your teacher password and click OK.

3 Choose the story elements and student results you want to print.  You can only print

results from steps students have completed.

4 Click Print Preview.  The information you selected opens in a separate window.

5 Click Print This Page, or choose Print from the File menu.

Story Check this box to print the picture and text for the current story.

Prediction Check this box to print the prediction that the student wrote.  

Questions Check this box to print the quiz questions and student's answers.

Specify whether you want to print the multiple-choice questions,

open-ended questions (typically questions 5, 8, and 9), or both.

You can also specify whether you want the correct answers

marked, the student's answers marked, or no answers marked.

Word List Check this box to print the word list (phonics levels only).

Retell Check this box to print the retell that the student wrote.

Vocabulary Check this box to print the current story's vocabulary words and

their definitions.

Difficult

Words

Check this box to print the unknown or difficult words that the

student clicked during the Cold Timing and Practice steps.

Story Results Check this box to print the student's results for the current story.

The results include the goal, cold timing score, pass timing

score, number of difficult words, expression rating from the pass

timing, retell word count, prediction text, retell text, quiz results

(which questions were answered correctly), and answers to the

open-ended questions.

Select All Click this to select all available story elements and student

results.
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Steps for Reading the Stories

This chapter provides in-depth instructions for the steps that students follow when

working with the stories in Read Naturally SE.  These are the Read Naturally steps:

1 Select a Story: The student clicks a picture to select a story.

2 Key Words: The student reads along as the key words are spoken, and then clicks

each word to see and hear its definition.

3. Prediction: The student uses the title, key words, and picture to write a prediction

of what the story is about.

4 Cold Timing: The student times him- or herself as he reads the story for the first

time and then views a graph of the results.

5 Read Along: The student reads along as the story is read to him or her.

6 Practice: The student practices reading the story on his or her own.

7 Quiz: The student answers questions about the story.

8 Retell: The student writes a brief summary in his or her own words of what the

story was about.

9 Pass: The teacher listens as the student reads the story. The student is timed in order

to verify that the student can read the story at his goal rate.  The teacher and student

then view the results together.

The Read Naturally strategy is generally most effective when all of the steps are

included.  However, Read Naturally SE allows you to omit steps for individual students

as needed.  For example, students who are reading well above their grade level may be

able to skip the Read Along step.

The sequenced levels follow the steps as described in this chapter.  The phonics levels

have differences and extra steps that are described in Chapter 6.

5
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Select a Story Step

Each reading level includes 24 stories in two sets of 12.  The set of stories available to 

a student is based on the reading level the teacher chose for the student in story options.

The students continue to work on the stories in a level until they pass all the stories in

the level or they are ready for a new level.  

If students didn't finish a story the last time they used Student Stories, they must

continue with that story and pass it before selecting a new one.  Student Stories marks

the pictures for the stories the student has passed.

To select a story:

1 The students click a picture to select a story from the ones available for their

reading level.

2 The students click Yes to confirm the story selection.

Click a picture
to select a story



Copyright © 2004–2007 Read Naturally, Inc. 43 Steps for Reading the Stories

SE Teacher's Guide

Key Words Step

This is a vocabulary step that teaches students some key words that are used in the story.

The students learn how to pronounce the words and what they mean.

To learn the key words:

1 The students listen and read along as the key words are read for them.

2 The students can then click each of the words to see and hear its definition.

3 The students click Next when they are ready for the next step.

Click for
definitions
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Prediction Step

In this step, the students use the story title, key vocabulary words, and picture to write a

brief prediction of what they think the story is about.  If needed, they can go back to the

Key Words step to review the key words.

This step is important because it teaches the students to prepare to read by thinking

about the topic briefly before beginning to read.  This shouldn't take more than a minute

or two, because you want the students to spend most of their time reading.

Teachers can set the time allowed for this step in the students' story options.

To write a prediction:

1 The students look at the picture, the key words, and the story title for clues about

what the story is about.

The students can also click Back if they want to review the key words and what

they mean.

2 In the box, the students type a prediction of what they think the story is about.

When typing, the students can use the Backspace, Delete, and arrow keys to move

around and edit text.

3 The students click Next when ready for the next step.  If the time allowed for the

prediction step expires, the program automatically advances to the next step.
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Cold Timing Step

In this step, SE times the students for one minute as they read the story for the first

time.  This gives you a baseline for measuring the students' improvement.  As they 

read, students should click words they don't know or have problems with.  This

increases a student's awareness of unknown words and alerts you to words or word

patterns you need to teach.

To do the cold timing:

1 If the teacher is required for cold timing, click the lock icon        , enter your teacher

password, and click OK.

2 The students can turn the reading guide on or off before they start reading.

3 The students click Start when they are ready to start reading.

If they need to stop and start over, they can click Stop and then click Start when

they are ready to start again.

4 The students read the story quietly and click words they don't know or have

problems with.  The words they click change color and are added to the 

Difficult Words list.

5 If the students finish the story, they should click the Finished button.  If students

click the Finished button early (before they actually finish the story), the program

makes them start over because the words per minute is too high.

6 If students are set up for one- or two-minute timings, a bell sounds when the time 

is up.  Students should click the last word they read when the bell sounded.

7 After the timing stops, students can click the difficult words they selected

(highlighted in red) to hear them spoken.
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8 The students click Next when they are ready to continue.  The Cold Timing Graph

displays.

The graph shows the number of words the students read correctly in one minute

during the cold timing.  SE calculates the number of words read correctly in the

cold timing by subtracting the number of difficult words the students clicked on

from the total number of words read.  

A black line marks the student's goal as set up in the story options.

9 The students click Next when they are ready for the next step.
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Read Along Step

In this step, the students read along while listening to a recording of the story, usually

three times.  Older students may need to read along only once or twice.  Younger or

very disabled students may need to read along four or more times.

In the students' story options, teachers specify the number of read alongs and the

reading speed of each read along.  Normally, the first read along is at the slowest 

speed, the second read along is 7.5% faster, and the third read along is 15% faster.

This step helps students learn new words and encourages proper pronunciation,

expression, and phrasing.  The students should quietly subvocalize as they read 

to ensure that they actually read along.

To read along:

1 The students click the Start button when they are ready to start reading along.

If they need to stop and start over, they can click Stop and then click Start when

they are ready to start again.

2 Each sentence in the story is highlighted as it is read.  Students should read aloud

quietly with the recording.

3 After each read along, students can click the vocabulary words (highlighted in blue)

to see and hear their definitions.  This helps the students learn the words.

4 After finishing the story, the students click Start to read along again until they have

read the required number of times.  A partial read along, where the student stops the

recording and restarts it, does not count.  To see how many read alongs the student

has remaining, hold the cursor over the Read Along tab.

5 After completing the required number of read alongs, students can either click Start

to read along again for more practice or click Next to continue with the next step.
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Practice Step

In this step, the students are timed as they practice reading the story without the

recording.  They are required to practice until they can read the story at or above 

the goal rate their teacher set for them.  It may take students six or seven practice

readings to reach their goal.

To practice reading the story:

1 The students can turn the reading guide on or off before they start reading.

The students can also click Back if they want to read along again.

2 The students click Start when they are ready to start practicing.

If they need to stop and start over, they can click Stop and then click Start when

they are ready to start again.

3 The students should read the story aloud but quietly.  If they finish the story, they

should click the Finished button.  If students are set up for whole-story timing, they

must click Finished to stop the timing.

� If students click the Finished button early (before they actually finish the story),

the program makes them start over because their words per minute is too high.

� As they read, students can click words they don't know to hear them spoken.

These are counted as difficult words.

4 If they are set up for one- or two-minute timings, a bell sounds when the time is up.

Students should click the last word they read when the bell sounded.

5 A box displays the number of words per minute they read.  If they did not reach

their goal, they must click Start to practice again.  If they do reach their goal, the

Next button is enabled, allowing them to continue with the next step.

6 Once students reach their goal, they can either click Start to practice again or click

Next to continue by taking the quiz.  
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Quiz Step

In this step, the students answer up to nine quiz questions about the story.  SE checks

the answers to the multiple-choice questions and repeats them if the students answer

them incorrectly.  During the Pass step, the teacher corrects the open-ended questions,

using the answers in the SE Answer Guide for guidance.

To answer the quiz questions:

1 For sequenced levels 1.0 through 5.0 and phonics levels .8 through 1.8, the story 

is on the same screen as the questions.  For sequenced levels 5.6 and above and

phonics levels 2.3 and above, students can click Review Story to view the story.

Students can also click the vocabulary words in blue to see and hear definitions.

2 The students answer each of the questions in order.  They click Done after

answering the open-ended questions.

3 SE checks the answers to the multiple-choice questions.  It re-asks any questions

that the students answered incorrectly until the answers are all correct.

4 The teacher corrects the open-ended questions during the Pass step, using the

answers in the SE Answer Guides for guidance.

Question Formats

The questions for the Read Naturally stories follow a specific format.  Understanding

the purpose of the questions helps you identify your students' comprehension problems.

You can use the Comprehension Details Report (see Chapter 7) to track which types of

questions a student answers correctly.  A pattern of errors may indicate that a student is

having trouble with a particular area of comprehension or does not know how to answer

a particular type of question.  In such cases, you may need to provide more instruction.

The table on the next page describes the question formats for the sequenced series.  (See

Chapter 6 for the question formats for the phonics series.)  
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The number and types of questions vary by level:

� Levels 1.0 and 1.5 include only the first five questions; however, due to the

constraints of stories written at the lower reading levels, the questions do not 

strictly adhere to the question formats described in the table.

� Levels 2.0 through 5.0 include only the first five questions.

� Levels 5.6 through 8.0 include all of the questions.

Question Type Description

1 Main Idea Asks students to identify the main idea of the story (not just

one fact from the story but what the story is mostly about).

2 Literal Asks students to recall a fact.  Students should refer back to

the text for verification.

3 Vocabulary Asks students to determine the meaning of a vocabulary

word from the context of the story.  Sometimes the word has

multiple meanings.  Students should use the surrounding

text to help decipher the word's meaning.

4 Inferential Asks students to make connections within the text, putting

together more than one fact from the story to draw a

conclusion.  These questions require students to look for

clues in the story.

5 Short

Answer

Asks students to use the information authors provide with

their own ideas.  Students should write sentences that stand

on their own.

6 Vocabulary This question is designed to develop vocabulary.  In most

cases, the question includes several words from the story.

The question sometimes asks the student to define words,

sometimes asks for synonyms, and sometimes asks for

antonyms.

7 Literal Asks students to recall details from the story.  The question

sometimes asks the students to put events in sequence.

Other times, the students must fill in the blanks of an excerpt

summary.  Some require a few short-answer responses.

8 Inferential Usually asks students to connect more than one fact from

the story to draw a conclusion.  Occasionally asks students

to differentiate between factual statements and opinions.

9 Summary Asks students to work on their summarizing skills.  The

question sometimes asks the student to support a particular

statement.  Other times it asks them to write a summary

statement for the information provided in the question.
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Retell Step

In this step, the students retell information from the story.   In the students' story

options, you can specify the number of minutes allowed for the Retell step.  You could

also disable this step in story options and have students tell you their retell orally instead

of typing it on the computer.

Note: Students using the phonics levels do not complete this step.  Instead, they

practice reading word lists after passing the story.  For more information, see

Chapter 6.

To type a retell:

1 If students want to review the story again before they type their retell, they can click

the Review Story button under the picture.  Students can only review the story

once.

2 The students type their retell in the box under the story title.  When typing, students

can use the Backspace, Delete, and arrow keys to move around and edit text.

3 When the students finish their retell, they click Next to continue with the next step.

(If the time allowed for the retell expires, a bell sounds, and they are not allowed to

write any more for their retell.  Student Stories automatically advances to the next

step.)

4 The teacher reviews the retell during the Pass step.
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Pass Step

The students pass a story only if they meet the following criteria:

� They reach their reading goal (words correct per minute).

� They make no more than three reading errors.

� They read with good expression.

� They answer the questions correctly.

If students do not pass, point out the areas they need to work on and assign some

remedial activity (for example, more read alongs or practice), and then test them again.

To pass a student:

1 After the students complete the previous step, they are held at the Ready to Pass

screen until the teacher has time to pass them.  A red "Ready to Pass" box in the

upper right-hand corner alerts the teacher that the student is ready to pass.

2 If the teacher is not immediately available (for example, he or she may be working

with another student), the student should click Start to practice some more until the

teacher has time to listen to him or her read.  When the teacher is ready to pass the

student, click Stop to stop the practice timing.

3 To enable the students to begin pass timing, the teacher clicks Pass in the lower

right corner, enters his or her password, and clicks OK.  

4 The students click Start when they are ready to start reading.  

5 As the students read, the teacher listens and counts the number of errors they make.

(See "Counting Words as Correct or Errors" on the next page for guidelines for

counting errors.)

Click to start
pass step
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6 If the students finish the story, they should click the Finished button.  If students are

set up for whole-story timing, they must click Finished to stop the timing.

If the students are set up for one- or two-minute timings, a bell sounds when the

time is up.  Students should click the last word they read when the bell sounded.

7 The teacher enters the number of errors the student made, rates the student's

expression, and then clicks Next.  Use the following guidelines to rate the 

student's expression:

Rating Description

1 The student reads haltingly, seldom uses phrasing, and reads without

expression.

2 The student reads phrases of three to four words (especially when

reading words the student knows well), and usually pauses for end

punctuation.

3 The student usually uses correct phrasing.  Appropriate use of

inflection and attention to punctuation occurs in some of the story.

4 The student reads conversationally, consistently using correct phrasing

and inflection and attending to all punctuation.

Counting Words as Correct or

Errors

While listening to students read, follow

these guidelines to help decide when

students make reading errors.

General Guidelines

� Count a word read correctly as

correct.

� Do not say the correct word after

the student has said the incorrect

word (unless the student stops and

is unable to continue).

� Wait three seconds before

supplying a word to a student

stopped on a word.

Count as Errors

� Mispronunciations and dropped

endings

� Out of sequence/transpositions

(count as two errors)

� Omissions

� Words supplied by teachers

� Substitutions with synonyms

� Repeated errors (count each time)

Do Not Count as Errors

� Mispronunciations due to dialect

and speech problems

� Repetitions

� Insertions

� Self-corrections
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8 The teacher reviews the student's answers to the open-ended questions, indicates

whether the answers are correct (Yes or No), and then clicks Next.  

� Use the answers in the SE Answer Guide to evaluate the student's answers.

� Students must change their answers for the open-ended questions if teachers

determine they are incorrect.

9 SE shows a summary of the pass results.  In order to pass, the students must meet

these criteria:

� They must meet their goal (words correct per minute).

� They cannot have more than three reading errors.

� They must read with good expression (a rating of 2 or higher).

� They must answer all of the questions correctly (even if it takes them more than

one try).

10 After reviewing the pass summary, the teacher can click Change Scores if he or she

needs to change the number of errors, expression rating, or evaluation of the short-

answer questions.

11 The teacher clicks Next when ready to continue.

12 If the student did not pass, SE shows the pass requirements results.  Green

checkmarks indicate the requirements that students met.  Red X's indicate 

the requirements that the student did not meet.

You should first review the students' work with them.  Click Review Work.  The

Results screen displays.
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� To review the questions, click a question number, and then choose an option to

show the student answer, show the correct answer, or clear the answer (remove

the check mark).  Click Back to return to the Results screen.

� When reviewing the retell, you can click Retell to view the story.  Click Close

to return to the Results screen.

After reviewing the student's work, click Back to return to the remedial screen.  SE

lets the teacher decide how to proceed.  You have the following options:

Pass the student

with the current

scores

1 Check the box for Pass with Current Scores, and click

Next.

2 Enter your teacher password, and click OK.

Have the student

repeat some of

the steps

Check one or more of the following boxes:

� Read Along: Specify how many read alongs the student

should go through.

� Practice: The student repeats the practice step until he

or she reaches the goal.

� Retest: The student repeats the pass timing.  This box is

automatically checked if you check either the Read Along

box or the Practice box.

Reset a story for

the student

If a student is struggling with a story and cannot pass it, you

can reset it and allow him or her to try it again later.

1 From the Edit menu, choose Story Options.

2 Enter your teacher password and click OK.

3 Choose the Advanced tab.

4 Choose the story you want to reset and click Reset.

5 Click Save.
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13 When the student passes, SE displays a Congratulations screen with a pass graph.

The red bar in the graph shows the number of words read correctly during the pass

timing.  The difference between the cold timing bar (blue) and the pass timing bar

(red) shows the student's progress.

14 From the Congratulations screen, you can click any of these buttons to continue:

� Quit: Closes Student Stories and returns to the login screen.

� Graph Stories: Displays a results graph of all the stories this student has read.

� Results: Displays the student's detailed results for the current story.

� New Story: Lets the student select another story to read.

To print the Congratulations screen, choose Print Screen from the File menu.  To

print the story and the student's results, choose Print from the File menu.
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Viewing Story Results

From the Congratulations screen, you can view two types of story results—a graph of

all the stories the student has passed so far and detailed results for the current story.

Stories Graph

The stories graph is a bar chart showing the cold timing and pass timing results for all

the stories in the level that the student has passed so far.  The graph provides a valuable

tool for monitoring students' progress.

To view the stories graph:

1 From the Congratulations screen, click Graph Stories.  The graph shows the

student's results in the order he or she read the stories.  Hold the cursor over 

a bar to see the story name for the results.

2 Click Back to return to the Congratulations screen.

Detailed Story Results

The detailed story results include the student's goal, the text he or she wrote for the

prediction, retell, and open-ended questions, and the scores from the cold timing

and pass timing.  If you want a printed version of this information, view and print the

Story Details Report, which is described in Chapter 7.
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To view the detailed story results:

1 From the Congratulations screen, click Results.  The detailed story results display,

including:

� The student's goal.

� The prediction and retell that the student wrote, plus the number of words in the

retell. Click Retell to view the story.

� The cold timing results, including the words correct per minute and the number

of difficult words the student clicked.

� The quiz results, including the student's answers to the open-ended questions.  A

red X by an open-ended question means the student's first response was wrong.

To view the questions, click a question number, and then choose an option to

show the student answer, show the correct answer, or clear the answer (remove

the check mark).  Click Back to return to the Results screen.

� The pass timing results, including the words correct per minute and the

expression rating.

� For phonics levels, the words correct per minute for the word list pass timing.

2 From the story results you can:

� Print the story and results (see "Printing Stories and Student Results" in 

Chapter 4).

� Click New Story to close the story and let the student select another story to

read.

� Click Back to return to the Congratulations screen.

� For phonics levels, you can click Word List to continue with the Practice Word

List step (see Chapter 6 for more information).
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Differences in the Steps 
for the Phonics Series

The phonics levels provide beginning readers with an opportunity to read words with

specific patterns in the context of a story and then to practice word lists that focus on

particular sounds.  

For the most part, the phonics levels follow the same steps as the sequenced levels as

described in Chapter 5.  However, there are some differences that are described in this

chapter.

This chapter includes the following information:

� Descriptions of the phonics levels available for Read Naturally SE.

� A summary of the differences between the phonics levels and the sequenced levels.

� Explanations of the Practice Word List and Pass Word List steps, which are

additional steps included in the phonics levels.

6
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Phonics Levels Available

Read Naturally offers the following phonics levels:

Phonics

Level
Featured Sounds Notes

.8 Word Families—Short Vowels

(short a, e, i, o, and u)

This level is easier to read than the 1.0

level.  The readability of the two levels is

similar according to the Fry and Spache

formulas.  However, the .8 level is easier

for beginining readers, because the

stories are shorter and make use of

sentence patterns.

1.3 Word Families—Long Vowels

(long a, e, i, o, and u)

1.8 Blends and Digraphs (bl, br, ch,

cl, cr, dr, fl, fr, gl, gr, ld, lk, nk,

pl, pr, sc, scr, sh, sk, sm, sn, sp,

spl, spr, st, str, th, tr, and wh)

2.3 R-Controlled and Other Letter

Combinations (alk, all, ar, au,

augh, aw, soft c, er, ew, gn, soft

g, ir, kn, oi, oo, or, ou, ough, ow,

oy, ph, ur, and wr)

2.6 Short Vowels (short a, e, i, o,

and u)

The short vowels level (2.6) is slightly

easier for students than the long vowels

level (2.7).  Students should complete

level 1.8 and/or level 2.0 before working

in either of these levels.  Some students

may also need to complete level 2.5

before working in these levels.

2.7 Long Vowels (long a, e, i, o,

and u)
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Summary of the Differences for the Phonics Series

The following table summarizes the differences in the Read Naturally steps for the

phonics levels compared to the sequenced level steps described in Chapter 5.

Step Differences in the Phonics Levels

Key Words All of the key words in a story feature a particular sound.  The

recording describes the featured sound and then reads the key

words.  Students should read along as the words are spoken.  

When you click a key word, the word is spoken but not

defined.  The definitions are not included, because the purpose

of the key words is to illustrate the featured sounds.

Quiz Phonics levels .8, 1.3, and 1.8 include five quiz questions in

the following format:

� The first four questions are multiple-choice questions that

ask students to find the word that correctly completes a

sentence.  The choices follow the sound patterns focused

on in the story.

� The fifth question asks students to answer a question by

writing a sentence.

Phonics levels 2.3, 2.6, and 2.7 include two quiz questions in

the following format:

� The first question is a paragraph with missing words or 

a cloze procedure.  Students complete the sentences by

choosing the correct word from a list.

� The second question is an open-ended question that

students answer by writing a sentence.

Retell The phonics levels do not include the Retell step.

Pass Results After the student passes the hot timing, a bar chart shows 

their cold and hot timing results, but there is no trophy picture.

Instead of a New Story button, there is a Word List button for

advancing to the word list steps.

The final pass results include the score from the word list pass

timing, but do not include a retell, since that step is skipped.

Practice Word List

and Pass Word List

The phonics levels include two word list steps after the Pass

step.  The word lists are intended to provide students with an

opportunity to improve their decoding skills.

� In the Practice Word List step, the student practices

reading the word lists.

� In the Pass Word List step, the teacher listens to the

students read the word lists in order to pass them.
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Practice Word List Step

The phonics levels include word lists that students practice reading after they have

passed the story.  Reading these words in the context of a story makes reading the 

words by themselves more meaningful and less frustrating for students.  After students

can read the word list in the time allowed, you pass them on the word list.

The students practice reading the word list in two directions.  Students first practice

reading down columns of words and then practice reading across rows of words.

Students must read the word list in both directions in the time allowed (45 seconds 

or one minute).

The word lists for levels .8, 1.3, 1.8, and 2.3 include most of the words with the featured

sounds from the story plus other words with the featured sounds.  The word lists for

levels 2.6 and 2.7 include all of the words with the featured sounds used in the story.

To practice reading the word lists:

1 From the pass results of a phonics level, click the Word List button.

2 The students click Start when they are ready to start practicing the word list.

If they need to stop and start over, they can click Stop and then click Start when

they are ready to start again.

3 The students first read quietly down the columns of words and click the Finished

Reading Down button when they finish.

As they read, students can click words they don't know to hear them spoken.
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4 The students then read quietly across the rows of words and click the Finished

Reading Across button when they finish.

The students' goal is to read the entire word list in both directions in the time

allowed (45 seconds or one minute).  If the bell sounds before they finish reading

the list, the students must practice the list again by clicking Start.

5 When students reach their goal practicing the word list, a red "Ready to Pass

Words" box in the upper right corner alerts the teacher that they are ready to 

pass the word list.

6 The students should click Start to continue to practice until the teacher is ready to

pass them on the word lists.
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Pass Word List Step

To pass the word list, students must meet two requirements:

� They must finish reading the word list in two directions (down and across) in the

time available (45 seconds or one minute).

� They cannot make more than three errors.

To pass a word list:

1 After students have reached their goal practicing the word lists, the teacher clicks

the Pass button.  (If the student is in the middle of a practice timing, click Stop

before you click Pass.)

2 The teacher enters his or her password and clicks OK.

3 The students click Start when they are ready to start reading the word list.

4 As the students read down the columns of words, the teacher listens and counts the

number of words they miss.  (See Chapter 5 for guidelines for counting errors.)

5 When the students finish reading down the word list, they click the Finished

Reading Down button.

6 The students then read across the rows of words.  The teacher listens and counts the

number of words they miss.  (See Chapter 5 for guidelines for counting errors.)

7 When the students finish reading across the word list, they click the Finished

Reading Across button.
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8 If students do not finish the word lists in both directions before the time is up, they

do not pass the word list.  The teacher must decide which of the following actions 

to take:

� Click Practice Again to have the students practice the word list again.  The

students can then try to pass the word list again with their teacher.

� Choose Word List from the Retest menu to have the students try to pass the

word list again without practicing.

� Click New Story to exit the word list steps and let the students choose another

story to read.

9 If students do finish the word list in both directions before the time is up, the

teacher enters the number of words missed and clicks OK.

� If students have more than three errors, they do not pass the story.  Teachers

must choose from the same three options described in step 8.

� If students have three or fewer errors, the screen displays their number of words

per minute.  

10 Click Next.  A Congratulations screen shows a bar chart of the cold and pass timing

scores and the word list pass score.

11 From the Congratulations screen, you can click any of these buttons to continue:

� Quit: Closes Student Stories and returns to the login screen.

� Graph Stories: Displays a results graph of all the stories this student has read.

(See "Viewing Story Results" in Chapter 5 for more information.)

� Results: Displays the student's detailed results for the current story, including

the score from the word list pass timing.  (See "Viewing Story Results" in

Chapter 5 for more information.)

� New Story: Lets the student select another story to read.
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Generating Teacher and 
Student Reports

Reports show summary and detail information about the teachers and students who use

Read Naturally SE.  Most of the reports are student reports that help you monitor

students' progress and determine when to intervene by providing extra coaching or

adjusting students' levels or goals.

This chapter includes procedures for generating reports and descriptions of the reports

that are available:

All teachers Teacher/Assistant Roster: Lists the teachers, their classes,

and the number of students in each class, plus any teacher

assistants.

All students for a

teacher

Student Enrollment Report: Lists basic information for the

students that are assigned to a teacher, regardless of whether

the students have started working in the program yet.

Needs At-A-Glance for Students Report: Summarizes the

status and results for each student who has completed at

least one story in the reporting period.  It also includes links 

to other student reports.

Students Active in Read Naturally Report: Lists the

teacher's students who have completed at least one story 

in the reporting period.

Individual students,

letters to parents

Periodic Report: A letter you can send to parents about the

progress their children have made in the Read Naturally

program.

Individual students,

details for a level

Level Details Report*: Includes a summary of results for

each story a student has passed at a given level.

Fluency Details Report*: Shows charts and data that help

you evaluate a student's reading fluency.

Comprehension Details Report*: Shows retell and quiz

results that help you evaluate the student's comprehension.

*All three of these reports include links to the Story Details

reports.

Individual students,

details for a story

Story Details Report: Provides a student's detailed results for

a specific story.

7



Generating a Teacher/Assistant Roster

The Teacher/Assistant Roster lists the teachers who use Read Naturally SE, their classes,

and the number of students in their classes.  Any teacher assistants are also listed.  Only

the school administrator can generate the Teacher/Assistant Roster report.  

To create a Teacher/Assistant Roster:

1 Log in to Teacher Management with the school administrator password.

2 From any of the tabs, click Reports.

3 In the Reports window, choose the School tab.

4 Specify the report period for which you want to include teacher data.

a Click in the "from" box, choose a starting date from the calendar, and click the

green check mark.

b Click in the "to" box, choose an ending date from the calendar, and click the

green check mark.

5 Click Create Report.  The report opens in a separate window.

6 To print the report, either click the Print This Report link or choose Print from the

File menu.

Generating Student Reports

When you generate the student reports, you specify the time period and students you

want to include in the report.  (The administrator also chooses the teacher whose

students are to be included.)  Read Naturally SE then generates either a student roster

report or a set of student progress reports.  The main progress report is a Needs At-A-

Glance report, from which you can view the other progress reports.

Note: If you generated reports previously, make sure you close the browser window

displaying the reports before you generate a new set of reports.  New reports

replace any existing reports, so not closing the report window could cause

unpredictable results.

To create the student reports:

1 Log in to Teacher Management with a teacher or school administrator password.

(Teacher assistants cannot generate reports.)

2 From any of the tabs, click Reports.
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3 From the Teacher tab of the Reports window, specify the report period for which

you want to include student data.  

a Click in the "from" box, choose a starting date from the calendar, and click the

green check mark.

b Click in the "to" box, choose an ending date from the calendar, and click the

green check mark.

4 Choose the type of report you want to generate—Student Roster or Progress Report.

� The student roster (Student Enrollment Report) lists basic information for

students enrolled in Read Naturally.

� The progress reports list results for students from their work in Student Stories.

5 If you are the administrator, choose a teacher from the list.  This is not required for

teachers, since they can generate reports only for their own students.

6 Select the student or students for whom you want to generate a report.

� To select one student, click the name.

� To select all of the teacher's students, click Select All.

� To select a group of students that are listed together, click the first student 

in the group, hold down the Shift key, and then click the last student in the

group.  (You can click a column heading to sort the students by that column.)

� To select multiple students that are not listed together, hold down the Control

key (Windows) or key (Macintosh) and then click the students you want to

include.

7 Click Create Report.  The Student Enrollment Report or Needs At-A-Glance

Report opens in a separate window.

8 You can print the report either by clicking the Print This Report link or by

choosing Print from the File menu.  From the Needs At-A-Glance Report, you can

also do the following:

� To view the Students Active for Teacher report, choose it from the Go To drop-

down list.

� To view a report for a specific student, click the report icon       for the report

you want to see.  Hold the cursor over an icon to see the name of the report it

links to.  The reports are described in this chapter, starting on the next page.
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Teacher/Assistant Roster

Purpose

This report lists the teachers, teacher assistants, classes, and number of students that are

set up in Read Naturally SE.

Key Information

This report lists the following information:

A The names of the teachers and teacher assistants that are set up in Read Naturally

SE.

B The names of the classes that are assigned to each teacher.

C The number of students that are assigned to each class.  

Things You Can Do From This Report

To print this report, either click the Print This Report link or choose Print from the

File menu.
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Student Enrollment Report

Purpose

This report lists basic information for the selected students that are assigned to the

teacher during the specified reporting period.  The report includes all of the students that

are enrolled in Read Naturally, regardless of whether the students have started working

in the program yet.  Use this report to help manage the students in the classroom.  

Key Information

For each student, this report lists the following information:

A The name of the student.

B The name of the class to which the student is assigned.

C The level in which the student is currently working.

D The student's current goal in words correct per minute.

E The student's password for logging in to Student Stories.

Things You Can Do From This Report

To print this report, either click the Print This Report link or choose Print from the

File menu.
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Needs At-A-Glance for Students Report

Purpose

This report can help you identify students who may need extra help in specific areas.

Within each column in the Fluency and Comprehension categories for a given level,

compare the "first three" and "last three" averages.  If you don't see improvement over

time, check the following: 

� Look at the Stories Passed column.  If the student has not completed at least six

stories at the current level during the report period, it may just be that the student

has not completed enough stories to show positive results.  In this situation, you

may wish to recreate this report using a longer reporting period, examine the

student's progress on other reading levels (if any), click on the report icons to gather

more information to help you determine if there is really a problem, and/or carefully

monitor the student's progress.  

� If the student has completed at least six stories during the reporting period, click 

the report icon under the fluency or comprehension columns, as appropriate, to 

see a more detailed report that can help you diagnose the student's specific areas 

of weakness.

Key Information

This report includes a summary for each student who completed at least one Read

Naturally story in the reporting period, including:

A The levels they've worked in, their goals, and the number of stories they've passed.

B The average time spent, average cold timing score, and average hot timing score

for the first three stories in the reporting period and for the last three stories in the

period.

C The percentage of quiz questions they've answered correctly for the first three

stories and the last three stories.

D The average number of words the student used to retell the first three stories and the

last three stories.

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view the Students Active for Teacher report, choose it from the Go To drop-down

list.

� To view a report for a specific student, click the report icon       for the report you

want to see.  Hold the cursor over an icon to see the name of the report it links to.
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Students Active in Read Naturally Report

Purpose

This report lists the active Read Naturally students who were assigned to the teacher

during the reporting period.  An "active" student is one who completed at least one Read

Naturally story during the reporting period.  

Key Information

The report lists the following information for each student:

A The student's name.

B The student's ID number.

C The class to which the student is assigned.

D The grade to which the student is assigned.

E The date the student was enrolled in Read Naturally SE.

F The reading level that was assigned to the student when he or she first enrolled.

G The student's current reading level.

Things You Can Do From This Report

� To print this report, either click the Print This Report link or choose Print from

the File menu.

� To view the Needs At-A-Glance Report, choose the report from the Go To drop-

down list.
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Periodic Report

Purpose

This report is a letter you can send to parents to inform them of the progress their

children have made in the Read Naturally program.  

Key Information

The report includes the following information for a specific student:

A The reporting period.

B The number of stories read.

C The starting and ending reading levels, pointing out that the ability to work in a

higher reading level is an indication of progress.

D The starting and ending goal rates, pointing out that an increase in goal rate is an

indication of progress.

E The percentage of questions the student answered correctly.

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view the Needs At-A-Glance report or the Students Active report, choose the

report from the Go To drop-down list.
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Level Details Report

Purpose

This report includes a summary of results for each story a student has passed at a given

level.  Stories are listed in order of completion, so you can compare the student's scores

for earlier and recent stories to see if the student is improving over time.  

Key Information

For each story the student has passed, the report lists the following information:

A The name and number of the story.

B The date the student started the story.

C The date the student passed the story.

D The student's reading rate goal, in words correct per minute.

E The student's cold timing score, in words correct per minute.

F The student's hot timing score, in words correct per minute.

G The percentage of questions the student answered correctly the first time he or she

took the quiz.

H The number of words in the student's retell.

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view a Story Details report for a specific story, click the name of the story in the

Story column.

� To view the Needs At-A-Glance report, Students Active report, Periodic Report,

Fluency Details report, or Comprehension Details report, choose the report from the

Go To drop-down list.
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Story Details Report

Purpose

This report provides a student's detailed results for a specific story.  

Key Information

A The Summary section of the report lists the following information:

� The title of the story.

� The student's goal.

� The cold timing results, including the number of errors.

� The hot timing results, including the number of errors and expression rating.

� The date the student started the story and the date he or she passed it.

� The amount of time the student spent on the story.

� The number of practices it took the student to achieve the goal rate.

B The Prediction and Retell Results section shows the numbers of words in the

student's prediction and retell and shows the text the student wrote for each.

C The Comprehension Quiz Results section shows the percentage of questions the

student answered correctly on the first try and indicates whether the answer to each

question was correct or incorrect.

D The Difficult Words section lists the difficult or unknown words the student clicked

during the Cold Timing and Practice steps.

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view the Needs At-A-Glance report, Students Active report, Periodic Report,

Level Details report, Fluency Details report, or Comprehension Details report,

choose the report from the Go To drop-down list.
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Fluency Details Report

Purpose

This report shows charts and data that reflect a student's reading fluency.  Monitoring

trends in a student's fluency can help you decide when it's time to adjust the student's

reading level or goal.

Key Information

This report includes the following information:

A A comparison of the average time spent per story, cold timing score, and hot timing

score for the first three stories and for the last three stories.

B A bar chart showing the hot and cold timing scores for the stories the student passed

in the level.  Hold the cursor over a bar to see the name of the story and the score.

C A summary of the results for each story the student passed, including the goal, cold

and hot timing scores, time spent per story, number of practices it took the student

to reach the goal, number of difficult words clicked, number of errors during the

cold and hot timing, and the expression rating.

D The difficult or unknown words the student clicked during the cold timing and

practice steps.

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view a Story Details report for a specific story, click the name of the story in the

Passed Story column.

� To view the Needs At-A-Glance report, Students Active report, Periodic Report,

Level Details report, or Comprehension Details report, choose the report from the

Go To drop-down list.



Copyright © 2004–2007 Read Naturally, Inc. 85 Generating Teacher and Student Reports

SE Teacher's Guide

A

B

C

D

Click to view a

Story Details

Report



Generating Teacher and Student Reports 86 Copyright © 2004–2007 Read Naturally, Inc.

SE Teacher's Guide

Comprehension Details Report

Purpose

This report shows charts and data from the student's retells and quiz results to help you

evaluate the student's comprehension of the stories.

Key Information

This report includes the following information:

A A chart showing the number of words the student used to retell each story.  Hold the

cursor over a bar to see the title of the story and the number of words in the retell.

Short retells may indicate that the student doesn't understand the stories.  (This chart

is not included for phonics levels, since those levels do not include a retell step.)

B A comparison of the average length of the retells for the first three stories and the

average length of the retells for the last three stories.  The retells should get longer

the more a student works with Read Naturally.

C A chart showing the percentage of questions the student answered correctly on the

first try for each story.   Hold the cursor over a bar to see the title of the story and

the percent correct.  The student should be able to answer at least 80% of the

questions correctly the first time (preferably 100%).  A lower percentage may

indicate that the student had trouble understanding the story and needs extra help.

D A comparison of the percentage of questions answered correctly for the first three

stories and the percentage of questions answered correctly for the last three stories.

Students should improve their performance on the quiz the more they work with

Read Naturally.

E A chart showing the percentage of questions answered correctly by question

number.  Hold the cursor over a bar to see the question type and percent correct.

For most levels, each question number is a particular type of question.  If a student

answers less than 80% of a question number, it may indicate that he or she has

problems in a given area of comprehension and needs extra coaching in that area.

Scores below 60% warrant immediate, direct intervention.  (This chart is not

included for phonics levels, since the questions for those levels are not categorized

by type.)

Things You Can Do From This Report

� To print the report, either click the Print This Report link or choose Print from the

File menu.

� To view a Story Details report for a specific story, click the name of the story in the

key under the Quiz Results by Story chart.

� To view the Needs At-A-Glance report, Students Active report, Periodic Report,

Level Details report, or Fluency Details report, choose the report from the Go To

drop-down list.
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